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Note: The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These
terms do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path
protection feature, which may be used in any topological network configuration. Cisco does not recommend
using its path protection feature in any particular topological network configuration.
This chapter explains how to manage Cisco ONS 15454 electrical, optical (OC-N), Ethernet, and virtual
concatenated (VCAT) circuits.
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Before You Begin
To create circuits, see Create Circuits and VT Tunnels.
To clear any alarm or trouble conditions, refer to the Cisco ONS 15454 Troubleshooting Guide.
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1. NTP-A329 Locate and View Circuits-Complete as needed.
2. NTP-A200 View Cross-Connect Card Resource Usage-Complete as needed.
3. NTP-A151 Modify and Delete Circuits-Complete as needed to edit a circuit name; change the active
and standby colors of spans; change signal fail (SF) and signal degrade (SD) thresholds, reversion
time, and path payload defect indication (PDI-P) settings for path protection circuits; or add or delete
a VCAT member.
4. NTP-A278 Modify and Delete Overhead Circuits and Server Trails-Complete as needed to change a
tunnel type, repair an IP circuit, or delete overhead circuits.
5. NTP-A78 Create a Monitor Circuit-Complete as needed to monitor traffic on primary bidirectional
circuits.
6. NTP-A328 Create a J0 Section Trace-Complete as needed to monitor interruptions or changes to
circuit traffic.
7. NTP-A79 Create a J1 Path Trace-Complete as needed to monitor interruptions or changes to circuit
traffic.
8. NTP-A293 Create a J2 Path Trace-Complete as needed to monitor interruptions or changes to circuit
traffic.
Contents
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9. NTP-A334 Bridge and Roll Traffic-Complete as needed to bridge and roll traffic.
10. NTP-A298 Reconfigure Circuits-Complete as needed to reconfigure circuits.
11. NTP-A301 Merge Circuits-Complete as needed to merge circuits.
12. NTP-A325 Manage VLANs-Complete as needed to view, create, or delete VLANs.
13. NTP-A348 Display IEEE 802.17 RPR Circuits-Complete as needed to view a map or list of IEEE
802.17 RPR circuits between ML-Series cards.

NTP-A329 Locate and View Circuits
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure allows you to locate and view circuits and spanning tree
information. You can also export circuit data from the Circuits and Edit
Circuits windows.
None
Circuit creation procedure(s) in Create Circuits and VT Tunnels
As needed
Onsite or remote
Retrieve or higher

1. Complete the "DLP-A60 Log into CTC" task at a node on the network where you want to view the
circuits. If you are already logged in, continue with Step 2.
Note: Do not check Disable Circuit Management in the Login dialog box. No circuits appear
if this option is checked.
2. As needed, complete the "DLP-A416 View Circuit Information" task.
3. As needed, complete the "DLP-A131 Search for Circuits" task.
4. As needed, complete the "DLP-A262 Filter the Display of Circuits" task.
5. As needed, complete the "DLP-A229 View Circuits on a Span" task.
6. As needed, complete the "DLP-A454 View the BLSR STS Squelch Table" task.
7. As needed, complete the "DLP-A455 View the BLSR VT Squelch Table" task.
8. As needed, complete the "DLP-A430 View Spanning Tree Information" task.
9. As needed, complete the DLP-A532 Export CTC Data.
Stop. You have completed this procedure.

NTP-A200 View Cross-Connect Card Resource Usage
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure allows you to view the percentage of cross-connect card
resources used by circuits that traverse or terminate at an ONS 15454.
XCVT, XC10G, or XC-VXC-10G cards must be installed.
DLP-A37 Install the XCVT, XC10G, or XC-VXC-10G Cards
As needed
Onsite or remote
Retrieve or higher

1. Complete the "DLP-A60 Log into CTC" task at the node where you want to view the cross-connect
card resource usage. If you are already logged in, continue with Step 2.
2. Click the Maintenance > Cross-Connect > Resource Usage tabs.
3. In the Summary area of the Resources Usage tab, view the following information:
♦ STS-1 Matrix-Provides the percent of cross-connect card STS-1 path resources that are in
use. 288 STS-1 paths are available for XCVT cards; 1152 STS-1 paths are available for
XC10G and XC-VXC-10G cards.
Before You Begin
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♦ VT Matrix Ports-Provides the percent of cross-connect card VT matrix ports that are in use.
Each port is one STS in size, and each can transport 28 VT1.5s or 21 VT2s. 24 VT matrix
ports are available for the XCVT and XC10G cards. 96 VT matrix ports are available for the
XC-VXC-10G cards.
♦ VT Matrix-Provides the percent of VT matrix resources that are in use. 672 are available for
the XCVT and XC10G cards. (672 is the number of VT matrix ports [24] multiplied by the
number of VT1.5s in an STS [28].) The VT matrix on the XC-VXC-10G has capacity for
2688 VT1.5 terminations (1344 VT1.5 bidirectional circuits) or 2016 VT2 terminations
(1008 VT2 bidirectional circuits).
4. In the VT Matrix Port Detail section, you can view details of the VT Matrix Port usage:
♦ Drop-Identifies the source slot, port, and STS.
♦ Tunnel Name-Displays the tunnel name if the port is used by a VT tunnel. VT tunnels use
VT matrix ports on the tunnel source and destination nodes. (VT tunnels do not use matrix
resources on pass-through nodes.)
♦ % Used-Shows the percent of the matrix port that are in use. For example, each matrix port
can carry 28 VT1.5s; if one STS carries seven VT1.5 circuits, the matrix port will be 25
percent used.
♦ Usage-Shows the port usage. For example, if one STS carries seven VT1.5 circuits, the
matrix port will show that 7 of 28 VT1.5 circuits are in use.
5. As needed, you can perform the following actions:
♦ Click the Refresh button to see an updated XC Resources view. For example, if other users
create circuits while you view the XC Resources tab, click Refresh to see the effects those
circuits have on the VT matrix usage.
♦ Click the Delete button to delete STSs that use VT matrix resources but no longer carry VT
circuits. This occasionally occurs when many VT circuits are added and deleted over a
period of time. Stranded STSs appear as STSs with 0 percent usage in the VT Matrix Port
Detail area. If stranded STSs appear, click the STS, then click Delete to free VT matrix
capacity.
Note: The Delete button requires a Superuser security level.
Note: VT tunnels might appear as STSs with 0 percent capacity used. These cannot be
deleted.
Stop. You have completed this procedure.

NTP-A151 Modify and Delete Circuits
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure modifies and deletes ONS 15454 circuits and tunnels.
None
Circuits must exist on the network. See Create Circuits and VT Tunnels for circuit
creation procedures.
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-A60 Log into CTC" task at a node containing the circuit that you want to
modify. If you are already logged in, continue with Step 2.
2. As needed, complete the "DLP-A230 Change a Circuit Service State" task.
3. As needed, complete the "DLP-A231 Edit a Circuit Name" task.
4. As needed, complete the "DLP-A232 Change Active and Standby Span Color" task.
5. As needed, complete the "DLP-A233 Edit Path Protection Circuit Path Selectors" task.
6. As needed, complete the "DLP-A263 Edit Path Protection Dual-Ring Interconnect Circuit Hold-Off
Timer" task.
NTP-A200 View Cross-Connect Card Resource Usage
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7. As needed, complete the "DLP-A333 Delete Circuits" task.
8. As needed, complete the "DLP-A437 Change a VCAT Member Service State" task.
9. As needed, complete the "DLP-A384 Add a Member to a VCAT Circuit" task.
10. As needed, complete the "DLP-A385 Delete a Member from a VCAT Circuit" task.
Stop. You have completed this procedure.

NTP-A278 Modify and Delete Overhead Circuits and Server Trails
Purpose

This procedure changes the tunnel type, repairs IP circuits, and deletes overhead
circuits and server trails.
None

Tools/Equipment
Prerequisite
Circuits must exist on the network. See Create Circuits and VT Tunnels.
Procedures
Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Caution! Deleting circuits can be service affecting and should be performed during a maintenance window.
1. Complete the "DLP-A60 Log into CTC" task for a node on the network where you want to delete the
circuit. If you are already logged in, continue with Step 2.
2. As needed, complete the "DLP-A332 Change Tunnel Type" task.
3. As needed, complete the "DLP-A336 Repair an IP Tunnel" task.
4. As needed, complete the "DLP-A334 Delete Overhead Circuits" task.
5. As needed, complete the "DLP-A453 Delete a Server Trail" task.
Stop. You have completed this procedure.

NTP-A78 Create a Monitor Circuit
This procedure creates a monitor circuit that monitors traffic on primary,
bidirectional circuits.
Tools/Equipment
None
Prerequisite
Bidirectional (two-way) circuits must exist on the network. See Create Circuits and
Procedures
VT Tunnels for circuit creation procedures.
Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: Monitor circuits cannot be used with EtherSwitch circuits.
Purpose

Note: For unidirectional circuits, create a drop to the port where the test equipment is attached.
1. Complete the "DLP-A60 Log into CTC" task at a node on the network where you will create the
monitor circuit. If you are already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View.
3. Click the Circuits tab.
4. Choose the bidirectional (two-way) circuit that you want to monitor and click Edit.
5. Verify that the circuit name is no longer than 44 characters. Monitor circuits append a "_MON" to
the circuit name. If the name is longer than 44 characters, edit the name in the Name field, then click
Apply.
6. In the Edit Circuit window, click the Monitors tab.
The Monitors tab displays ports that you can use to monitor the circuit.
NTP-A151 Modify and Delete Circuits
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Note: The Monitors tab is only available when the circuit has a DISCOVERED status.
7. On the Monitors tab, choose the monitor source port. The monitor circuit will display traffic coming
into the node at the port you choose.
Note: In Figure 7-1, you would choose either the DS1-14 card (to test circuit traffic entering
Node 2 on the DS1-14) or the OC-N card at Node 1 (to test circuit traffic entering Node 1 on
the OC-N card).
8. Click Create Monitor Circuit.
9. In the Circuit Destination section of the Circuit Creation wizard, choose the destination node, slot,
and port, and as applicable, STS, VT, and/or DS1 for the monitored circuit.
Note: In the Figure 7-1 example, the monitor circuit destination is Port 2 on the EC1-12
card.
10. Click Next.
11. In the Circuit Routing Preferences area, review the monitor circuit information. If you want the
monitor circuit routed on a bidirectional line switched ring (BLSR) protection channel, click
Protection Channel Access.
12. Click Finish.
13. In the Edit Circuit window, click Close. The new monitor circuit appears on the Circuits tab.
Figure 7-1 shows a sample monitor circuit setup. VT1.5 traffic is received by Port 1 of the
EC1-12 card at Node 1. To monitor the VT1.5 traffic, test equipment is plugged into Port 2
of the EC1-12 card and a monitor circuit to Port 2 is provisioned in CTC. (Circuit monitors
are one-way.) This example assumes that circuits have been created.
Figure 7-1: VT1.5 Monitor Circuit Received at an EC1-12 Port

Stop. You have completed this procedure.

NTP-A328 Create a J0 Section Trace
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a repeated, fixed-length string of characters used to monitor
interruptions or changes to traffic between nodes.
At least one of the following cards must be installed: MRC-2.5G-4, MRC-12 or
OC192-XFP.
None
As needed (optional if path trace is set)
Onsite or remote
Provisioning or higher

1. Complete the "DLP-A60 Log into CTC" task at a node on the network where you will create the
section trace. If you are already logged in, continue with Step 2.
2. In node view, double-click the MRC-2.5G-4, MRC-12 or OC192-XFP card.
NTP-A78 Create a Monitor Circuit
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3. Click the Provisioning > Line > Section Trace tabs.
4. From the Port drop-down list, choose the port for the section trace.
5. From the Trace Mode drop-down list, enable the section trace expected string by choosing Auto or
Manual:
• Auto-The first string received from the source port is automatically provisioned as
the current expected string. An alarm is raised when a string that differs from the
baseline is received.
• Manual-The string entered in the Current Expected String field is the baseline. An
alarm is raised when a string that differs from the Current Expected String is
received.
6. In the Section Trace String Size area, click 1 byte, 16 byte, or 64 byte. In the New Transmit String
field, enter the string that you want to transmit. Enter a string that makes the destination port easy to
identify, such as the node IP address, node name, or another string. If the New Transmit String field
is left blank, the J0 transmits a string of null characters.
7. If you set the Section Trace Mode field to Manual, enter the string that the destination port should
receive from the source port in the New Expected String field. If you set Section Trace Mode to
Auto, skip this step.
8. Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm
indication signal (AIS) and remote defect indication (RDI) when the STS Section Trace Identifier
Mismatch Path (TIM-P) alarm appears. Refer to the Cisco ONS 15454 Troubleshooting Guide for
descriptions of alarms and conditions.
9. Click Apply.
10. After you set up the section trace, the received string appears in the Received field. The following
options are available:
• Click Hex Mode to display section trace in hexadecimal format. The button name
changes to ASCII Mode. Click it to return the section trace to ASCII format.
• Click the Reset button to reread values from the port.
• Click Default to return to the section trace default settings (Section Trace Mode is
set to Off and the New Transmit and New Expected Strings are null).
Caution! Clicking Default will generate alarms if the port on the other end is provisioned with a different
string.
The expect and receive strings are updated every few seconds if the Section Trace Mode field is set
to Auto or Manual.
Stop. You have completed this procedure.

NTP-A79 Create a J1 Path Trace
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a repeated, fixed-length string of characters used to
monitor interruptions or changes to circuit traffic.
ONS 15454 cards capable of transmitting and/or receiving path trace must be
installed. See Table 19-3 for a list of cards.
Path trace can only be provisioned on OC-N (STS) circuits. See Create
Circuits and VT Tunnels for OC-N circuit creation procedures.
As needed
Onsite or remote
Provisioning or higher

NTP-A328 Create a J0 Section Trace

6

ONS_15454_Procedure_Guide_R8.5.1_--_Manage_Circuits
Note: You cannot create a J1 path trace on a TL1-like circuit.
1. Complete the "DLP-A60 Log into CTC" task at a node on the network where you will create the path
trace. If you are already logged in, continue with Step 2.
2. Complete the following tasks as needed:
♦ As needed, complete the "DLP-A264 Provision a J1 Path Trace on Circuit Source and
Destination Ports" task.
♦ As needed, complete the "DLP-A137 Provision Path Trace on OC-N Ports" task.
Stop. You have completed this procedure.

NTP-A293 Create a J2 Path Trace
This procedure creates a repeated, fixed-length string of characters used to
monitor interruptions or changes to circuit traffic.
Tools/Equipment
DS3XM-12 card or DS1/E1-56 card
Prerequisite Procedures
See Create Circuits and VT Tunnels for DS-3 circuit creation procedures.
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: You cannot create a J2 path trace on a TL1-like circuit.
Purpose

Note: This procedure assumes that you are setting up path trace on a bidirectional circuit and setting up
transmit strings at the circuit source and destination.
1. Complete the "DLP-A60 Log into CTC" task at a node on the network where you will create the path
trace. If you are already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View.
3. Click the Circuits tab.
4. For the VT circuit you want to monitor, verify that the source and destination ports are on a card that
can transmit and receive the path trace string.
Note: If neither port is on a transmit/receive card, you will not be able to complete this
procedure. If one port is on a transmit/receive card and the other is on a receive-only card,
you can set up the transmit string at the transmit/receive port and the receive string at the
receive-only port, but you will not be able to transmit in both directions.
5. Choose the VT circuit you want to trace, then click Edit.
6. In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A
detailed map of the source and destination ports appears.
7. Provision the circuit source transmit string:
1. On the detailed circuit map, right-click the circuit source port (the square on the left or right
of the source node icon) and choose Edit J2 Path Trace (port) from the shortcut menu.
2. In the New Transmit String field, enter the circuit source transmit string. Enter a string that
makes the source port easy to identify, such as the node IP address, node name, circuit name,
or another string. If the New Transmit String field is left blank, the J2 transmits a string of
null characters.
3. Click Apply, then click Close.
8. Provision the circuit destination transmit string:
1. On the detailed circuit map, right-click the circuit destination port and choose Edit Path
Trace from the shortcut menu.
2. In the New Transmit String field, enter the string that you want the circuit destination to
transmit. Enter a string that makes the destination port easy to identify, such as the node IP
address, node name, circuit name, or another string. If the New Transmit String field is left
NTP-A79 Create a J1 Path Trace
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blank, the J2 transmits a string of null characters.
3. Click Apply.
9. Provision the circuit destination expected string:
1. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or
Manual from the Path Trace Mode drop-down list:
◊ Auto-The first string received from the source port is automatically provisioned as
the current expected string. An alarm is raised when a string that differs from the
baseline is received.
◊ Manual-The string entered in the Current Expected String field is the baseline. An
alarm is raised when a string that differs from the Current Expected String is
received.
2. If you set the Path Trace Mode field to Manual, enter the string that the circuit destination
should receive from the circuit source in the New Expected String field. If you set Path Trace
Mode to Auto, skip this step.
3. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match
check box if you want to suppress the AIS when a C2 mismatch occurs.
4. Click Apply, then click Close.
Note: It is not necessary to set the format (16 or 64 bytes) for the circuit destination expected
string; the path trace process automatically determines the format.
10. Provision the circuit source expected string:
1. In the Edit Circuit window (with Show Detailed Map chosen), right-click the circuit source
port and choose Edit Path Trace from the shortcut menu.
2. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or
Manual from the Path Trace Mode drop-down list:
◊ Auto-Uses the first string received from the port at the other path trace end as the
baseline string. An alarm is raised when a string that differs from the baseline is
received.
◊ Manual-Uses the Current Expected String field as the baseline string. An alarm is
raised when a string that differs from the Current Expected String is received.
3. If you set the Path Trace Mode field to Manual, enter the string that the circuit source should
receive from the circuit destination in the New Expected String field. If you set Path Trace
Mode to Auto, skip this step.
4. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match
check box if you want to suppress the AIS when a C2 mismatch occurs.
5. Click Apply.
Note: It is not necessary to set the format (16 or 64 bytes) for the circuit source expected
string; the path trace process automatically determines the format.
11. After you set up the path trace, the received string appears in the Received field on the path trace
setup window. The following options are available:
♦ Click Hex Mode to display path trace in hexadecimal format. The button name changes to
ASCII Mode. Click it to return the path trace to ASCII format.
♦ Click the Reset button to reread values from the port.
♦ Click Default to return to the path trace default settings (Path Trace Mode is set to Off and
the New Transmit and New Expected Strings are null).
Caution! Clicking Default will generate alarms if the port on the other end is provisioned with a different
string.
The expect and receive strings are updated every few seconds if the Path Trace Mode field is set to
Auto or Manual.
13. Click Close.

NTP-A293 Create a J2 Path Trace
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The detailed circuit map indicates path trace with an M (manual path trace) or an A
(automatic path trace) at the circuit source and destination ports.
Stop. You have completed this procedure.

NTP-A334 Bridge and Roll Traffic
Purpose
Tools/Equipment

Prerequisite
Procedures

This procedure reroutes live traffic without interrupting service. You can use the Bridge
and Roll wizard for maintenance functions such as card replacement or load balancing.
A circuit consists of a source facility, destination facility(s), and intermediate facilities
(path).
None
• Circuits must exist on the network. See Create Circuits and VT Tunnels for
circuit creation procedures.
• To route circuits on protected ports, you must create a protection group using
the "DLP-A73 Create a 1+1 Protection Group" task or the NTP-A126 Create a
BLSR.
• When a roll involves two circuits, a data communications channel (DCC)
connection must exist. See the "DLP-A377 Provision Section DCC
Terminations" task.
• Use the NTP-A329 Locate and View Circuits to verify that the planned Roll To
paths are in service. Verify that the planned Roll To and Roll From paths are
not in the Roll Pending status, used in test access, or used in a loopback. Refer
to the Cisco ONS 15454 Troubleshooting Guide to clear any alarms.

Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning and higher
Note: Using the bridge and roll feature, you can upgrade an unprotected circuit to a fully protected circuit or
downgrade a fully protected circuit to an unprotected circuit.
Caution! Performing bridge and roll on an STS192C might cause a traffic hit up to and including 50 ms.
1. Complete the "DLP-A60 Log into CTC" task at the ONS 15454 circuit source node. If you are
already logged in, continue with Step 2.
2. As needed, complete the "DLP-A463 Roll the Source or Destination of One Optical Circuit" task.
3. As needed, complete the "DLP-A464 Roll One Cross-Connect from an Optical Circuit to a Second
Optical Circuit" task.
4. As needed, complete the "DLP-A465 Roll Two Cross-Connects on One Optical Circuit Using
Automatic Routing" task or the "DLP-A466 Roll Two Cross-Connects on One Optical Circuit Using
Manual Routing" task.
5. As needed, complete the "DLP-A467 Roll Two Cross-Connects from One Optical Circuit to a
Second Optical Circuit" task.
6. As needed, complete the "DLP-A489 Cancel a Roll" task.
7. As needed, complete the "DLP-A468 Delete a Roll" task. Use caution when selecting this option.
Delete a roll only if it cannot be completed or canceled. Circuits might have a PARTIAL status when
this option is selected.
Stop. You have completed this procedure.

NTP-A334 Bridge and Roll Traffic
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NTP-A298 Reconfigure Circuits
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure rebuilds circuits, which might be necessary when a large number of
circuits are in the PARTIAL status.
None
None
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-A60 Log into CTC" task. If you are already logged in, continue with Step 2.
2. Click the Circuits tab.
3. Highlight the circuits that you want to reconfigure.
4. From the Tools menu, choose Circuits > Reconfigure Circuits.
5. In the confirmation dialog box, click Yes to continue.
6. In the notification box, view the reconfiguration result. Click Ok.
Stop. You have completed this procedure.

NTP-A301 Merge Circuits
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This procedure merges two circuits that create a single, contiguous path but are
separate circuits because of different circuit IDs or conflicting parameters. A merge
combines a single master circuit with one or more circuits.
None
None
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-A60 Log into CTC" task. If you are already logged in, continue with Step 2.
2. Click the Circuits tab.
3. Click the circuit that you want to use as the master circuit for a merge.
4. Click Edit.
5. In the Edit Circuits window, click the Merge tab.
6. Choose the circuits that you want to merge with the master circuit.
7. Click Merge.
8. In the confirmation dialog box, click Yes to continue.
9. In the notification box, view the merge result. Click Ok.
Stop. You have completed this procedure.

NTP-A325 Manage VLANs
Purpose
This procedure allows you to view, create, or delete VLANs.
Tools/Equipment
None
Prerequisite Procedures None

NTP-A298 Reconfigure Circuits
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Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: Remove all unused VLANs. The recommended number of VLANs is a maximum of 100; if more than
100 VLANs exist, the E-Series cards may have problems accepting new VLANs.
1. Complete the "DLP-A60 Log into CTC" task. If you are already logged in, continue with Step 2.
2. From the Tools menu, choose Manage VLANs. The All VLANS dialog box appears listing all of the
VLAN topologies in the network.
3. Complete the following as necessary:
♦ To add a VLAN, complete the "DLP-A452 Create a VLAN" task.
♦ To delete a VLAN, complete the "DLP-A335 Delete VLANs" task.
Stop. You have completed this procedure.

NTP-A348 Display IEEE 802.17 RPR Circuits
Purpose

This procedure displays a map of and provides information about IEEE 802.17
Resilient Packet Ring (RPR) circuits between ML-Series cards. For more information
about IEEE 802.17 RPR, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH
Ethernet Card Software Feature and Configuration Guide.
None

Tools/Equipment
Prerequisite
DLP-A556 Provision the Card Mode for ML-Series Ethernet Cards
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: CTC does not support the display of Cisco proprietary RPR circuit topology.

Note: CTC does not support provisioning or maintenance of IEEE RPR rings. You must use Cisco IOS.
1. Complete the "DLP-A60 Log into CTC" task at the node where you will view the circuit. If you are
already logged in, continue with Step 2.
2. From network, shelf, or ML-Series card view, click the Circuits tab and select the circuit where you
want to display information.
Note: If you are viewing the circuits list from network or shelf view, you must look at the
Source and Destination fields to determine which circuits are RPR circuits.
3. Click Tools > Circuits > Show RPR Circuit Ring.
The map displays the following information about each IEEE 802.17 RPR circuit:
• Circuit name
• Type
• Size
• OCHNC Wlen
• Direction
• Protection
• Status
• Source
• Destination
• # of VLANs
• # of Spans
NTP-A325 Manage VLANs
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• State
• Loopback
4. Repeat this procedure as necessary for additional 802.17 RPR circuits you want to display.
Stop. You have completed this procedure.

NTP-A348 Display IEEE 802.17 RPR Circuits
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